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Welcome

Avenza welcomes you to mapmaking in the 21st century!

Combined with Adobe Illustrator, MAPublisher has revolutionized the art of mapmaking by allowing spatial data
files to be used to create maps inside a vector graphics program. MAPublisher allows all your cartographic tasks to
be performed where they should be done; in a powerful graphics environment.

MAPublisher LabelPro™ revolutionizes the way users can label map data, including using symbols as labels, conflict
resolution, and highly configurable rule-based labeling options. The MAP LabelPro engine uses map data attributes
for labeling with styles, rules and controls configured through an intuitive, easy-to-use Graphical User Interface.

This tutorial assumes that the user is familiar with Adobe Illustrator CS4/CS5/CS5.1, and has at least a basic
understanding of MAPublisher tools and features. Not all MAPublisher tools are explained in this document. This
tutorial should be used in conjunction with the MAPublisher 8.7 User Guide, MAPublisher 8.7 Tutorial Guide and
Quick Start Guide for an understanding of all the other MAPublisher tools.

By following this tutorial, you will learn how to setup and use the MAP LabelPro labeling engine to label your

map created in MAPublisher. Working on a provided map, users learn to create rules and styles for labeling in an
automated and efficient way.

MAP LabelPro Tutorial Data

This tutorial will use Adobe lllustrator files and MAP LabelPro rules installed with MAPublisher 8.7. You can find the
MAP LabelPro Tutorial data in the following location on your hard drive:

Windows XP
C:\Documents and Settings\All Users\Shared Documents\Avenza\MAPublisher 8\MAP LabelPro Tutorial & Data\Data

Windows Vista and Windows 7
C:\Users\Public\Public Documents\Avenza\MAPublisher 8\MAP LabelPro Tutorial & Data\Data

Note: This data may be accessed through shortcuts available in the Windows start menu

Mac0SX
/Applications/Avenza/MAPublisher 8/MAPublisher Tutorials/MAP LabelPro Tutorial & Data/Data

You are encouraged to experiment with your own data to gain additional experience with MAPublisher tools.

Tutorial data courtesy of City and County of San Francisco (San Francisco Enterprise GIS program SFGIS).

MAPublisher 8.7 LabelPro Tutorial il
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1.1 Purpose

1 Preliminaries

The purpose of this exercise is to use MAP LabelPro to create labels for a simple map of downtown San Francisco,
California, USA. For this exercise, Avenza has prepared the necessary map file created with MAPublisher 8.7 and
Adobe lllustrator, based on City and County of San Francisco GIS data (San Francisco Enterprise GIS program SFGIS).
The map contains all the different type of features (point, line and area) for labeling and/or obstacle purpose.

In this exercise, you will start by preparing the file and examining the data to familiarize yourself with the
prerequisites to using MAP LabelPro. Then, the labeling will be done in two steps: a main labeling session (labeling
public schools, streets, interstates, highways and land areas in one run) and a secondary session (labeling parks
only, using the other labels as obstacles). Although the presented settings are valid only for the map data they are
based on, the principles are applicable for your own designs.

1.2 Know your data

The MAP LabelPro Tutorial data folder contains a ready-to-use Adobe lllustrator template file containing a map of
downtown San Francisco (MAPLabelPro_Tutorial.ait). Here is a description of the layers present in the file and how
they will be used during the labeling process.

1.2.1 San Francisco map description

Layer name Type Description Labeling Attribute Obstacle?
(label source |ayers) Session #1 | Session #2
Text layers
LAND_labels Text Land labels - - No
SCHOOL_labels Text School labels - - Yes
STREET _labels Text Street labels - - Yes
PARK_labels Text Park labels - - -
HIGHWAY_INTERSTATE_labels | Text Labels for highways and interstates | - - Yes
SUPPRESSED_labels Text Labels that couldn't be placed - - No
based on the specified rules.
MAP_TITLE Text Map title (San Francisco) - Yes No
MAP Layers
Public_Schools_point Point Public school locations SCHOOL_NAME Yes Yes
Post_Offices_point Point Post office locations - Yes Yes
Highways_line Line Highway roads HIGHWAY_NUMBER Yes Yes
Interstates_line Line Interstate roads INTERSTATE_NUMBER | Yes Yes
Ramp_line Line Ramps to highways - No No
Streets_line Line San Francisco street network STREETNAME No No
Land_area Area Land areas AREA_NAME No No
Parks_area Area Park areas PARK_NAME Yes No

MAPublisher 8.7 LabelPro Tutorial
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Layer name Type Description Labeling Attribute Obstacle?
(label source |ayers) Session #1 | Session #2
Other Layers
Scale_Bar Legend | Scale bar - -
background Area Blue background to represent | - -
the sea

All map layers were imported from City and County of San Francisco GIS data (San Francisco Enterprise GIS program
SFGIS) in ESRI shapefile format and cropped to the area of interest. The map design (symbols and line styles) was
created by Avenza Systems.

1.2.2 Styles and rules

MAPublisher is installed with predefined styles and rules to use for the MAP LabelPro settings in this tutorial. These
configuration files are saved to one of three folders depending on the data type layer, &/ Area, [Li| Line or | P Point,
they are associated with.

Layer Name Type Style Rule

\LabelPro\Styles \LabelPro\Rules
Public_Schools_point Point School_Label_Style School_Label_Rule
Interstates_line Line Interstate_Label_Style Interstate_Label_Rule
Highways_line Line Highway_Label_Style Highway_Label_Rule
Streets_line Line Street_Label Style Street_Label Rule
Parks_area Area - -
Land_area Area Land_Label_Style Land_Label_Rule

The style and rules for the Parks_area layer will be created during the second labeling session of this exercise.
The default location of the Rules and Styles folders is:

Windows XP: C:\Documents and Settings\All Users\Application Data\Avenza\MAPublisher 8\LabelPro\Rules
Windows Vista: C:\ProgramData\Avenza\MAPublisher 8\LabelPro\Rules
Mac OS X: Applications/Avenza/MAPublisher 8/MAPublisher Plug-In/LabelPro/Rules

Note: The MAP LabelPro tutorial data folder also contains a backup for these rules and styles

1.2.3 Important note for MAPublisher LabelPro evaluation users

The evaluation version of MAPublisher LabelPro scrambles the text of placed labels but preserves the case,
spacing and punctuation so that it simulates how actual labels would be placed. Therefore, evaluation users will
experience a different result with the MAP LabelPro settings of this tutorial than licensed users. The results will be
shown and differences explained at the end of this guide. In evaluation mode, the scrambling process noticeably
slows the speed of labeling.

é MAPublisher 8.7 LabelPro Tutorial
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2 Getting Started

2.1 Open tutorial document

1. Inthe Adobe Illustrator main menu, choose File> Open and open the template file MAPLabelPro_Tutorial.ait located
in \MAPublisher 8\MAP LabelPro Tutorial Guide & Data\Data.
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An artboard containing a map of San Francisco opens. All the data information to be used for labeling is present,
except for the text labels. Please see the table in the Preliminaries chapter for the description of the layers.

2. Because the file was opened from a template, a new untitled document was created. Choose from the Adobe
lllustrator main menu File > Save As to save the file as San Francisco.ai.

Note: Customize the Adobe lllustrator workspace to make it easier to access panels. It may look different than
the image above. Read Customizing the workspace in the Adobe lllustrator help guide for more information.
Review also MAPublisher Preferences in the MAPublisher 8.7 User Guide.

2.2 Examine MAP Attributes available for labeling

MAP LabelPro extracts label data from the attribute table for each MAP Layer to be labeled. Therefore, it is good
practice and often required to examine or edit attribute information using the MAP Attributes panel. Edits can
include: creating a new column to enter attribute values, joining tables to import additional attribute information
from an external file, correcting spelling, changing the case of text and more.

For this exercise, all attributes are ready to use for labeling. Follow the steps here to examine them and familiarize
yourself with the data.

Note: For more information on the MAP Attributes panel, please refer to the MAPublisher 8.7 User Guide, chapter 5.
For more exercises, please see the MAPublisher Quick Start Guide and MAPublisher Tutorial Guide.

MAPublisher 8.7 LabelPro Tutorial 7
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3.

In the Adobe lllustrator Layers panel, click the target button & next to the Public_Schools_point layer to select

all artwork on the layer.
Open the MAP Attributes panel (from the Adobe Illlustrator main menu, choose Window > MAPublisher> MAP

Attributes or click the MAP Attributes button on the MAPublisher toolbar. ).

The Public_Schools_point layer contains four visible attribute columns: OBJECTID, FACILITY_I, DEPTNAME and
SCHOOL_NAME. The SCHOOL_NAME attribute column will be used for labeling the school points.

“

i g%

MAP ATTRIBUTES =
Layer: | P! Public_Schaols_point (24 points selected) -
[ ORIECTID FACILITY 1 DEPTNAME SCHOOL NAME |-
1] 1,813 0000003094 SF Unified School District (SFUSD)  FRANCISCO MIDDLE SCHOOL  |=)|
2 1,914 0000003095 SF Unified School District (SFUSD)  YICK WOO SCHOOL
3 1,015 0000003095 SF Unified School District (SFUSD)  GARFIELD SCHOOL
4 1,919 0000003102 SF Unified School District (SFUSD)  JEAN PARKER SCHOOL
5 1,920 0000003104 SF Unified School District (SFUSD)  SPRING VALLEY SCHOOL
3 1,922 0000003106 SF Unified School District (SFUSD)  CHINESE EDUCATION CENTER
W4 1of 24 b (1A
24 points selected (PE=EE -

Select all artwork on the Interstates_Line layer and view the attributes in the MAP Attributes panel.

“

LN

MAP ATTRIBUTES

Layer: | [Ll Interstates ine (4lines selected) -
[SISTREETMNAME  [J]INTERSTATE_NUMBER i

1 VAN MESS AVE 101

2 VAN MESS AVE 101

3 LOMBARD 5T 101

4 LOMBARD 5T 101

W] 4] tof | b (]

4 lines selected @@E@

The INTERSTATE_NUMBER attribute column will be used for labeling these roads.

Note: Notice that the INTERSTATE_NUMBER attribute is of type integer [I1. All types of attributes may be used for

8

labeling with MAP LabelPro.

Select all on the Highways_line layer and view the attributes in the MAP Attributes panel. HIGHWAY_NUMBER
will be used for labeling. View the attributes of the remaining layers: Streets_line, Parks_area, and Land_area.

Refer to the San Francisco description table in section 1.2.1 to see the attributes that will be used for labeling.
Close the MAP Attributes panel after reviewing it.

Knowing this information, we are ready to use the MAP LabelPro function to generate map labels for the San
Francisco downtown map.

MAPublisher 8.7 LabelPro Tutorial
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3 Labeling Session #1

In this first labeling session, multiple layers will be labeled in a single run of the MAP LabelPro function. The
objectives for this session are to:

Add labels for school as a first priority (source layer Public_Schools_point).

Label the interstate roads with interstate shield symbols containing the interstate number (source layer
Interstates_line).

Label the highway roads with highway shield symbols containing the highway number (source layer
Highways_line).

Add street names (source layer Streets_line).

Add names for land areas, written in the sea to make the map more readable (source layer Land_area).
Make sure that the school and road names do not overlap with the post office and school symbols and park
area, and do not cross highways and interstates line (obstacle layers: Post_Offices_point, Public_Schools_
point, Parks_area, Interstates_line and Highways_line).

To start the MAP LabelPro Editor, click the MAP LabelPro button IEEI on the MAPublisher Toolbar.

MAP LabelPro———

| EEEEEY N

¢ 0 TUYVE USSP EHOAES Tieel CTCoBLF @O Lol Eare

The MAP LabelPro dialog box opens.

MAP LabelPro

Source Attribute Destination  Priority Style Rules Suppression Layer | | Save &Label

Save

Cancel

_SEtup Layers..
Advanced...
@ Label all art on source layers

, Import Settings...
ARG T
Export Settings...

Obstacle Layers: Source Art:

All layers have to be configured before labeling with MAP LabelPro. The general MAP LabelPro workflow: setup
source layers, specify attribute to be labeled, set label destination or suppression layers, set label priority and define
layer styles and rules.

If the dialog box needs to be closed before all configurations are done, make sure to click the Save button. If
labeling has been executed and an Undo action is used afterwards, the configurations in MAP LabelPro will revert
to the configuration before the labeling was executed. To ensure that your configuration is saved, click the Save
button before labeling.

MAPublisher 8.7 LabelPro Tutorial 9
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3.1 Layers and obstacles setup

1. Inthe MAP LabelPro editor dialog box, click the Setup Layers button.
2. Inthe Setup Layers dialog box, click the Label check box for each of the following layers to enable them as
source layers:
«  Public_Schools_point
« Highways_line
+ Interstates_line
+  Streets_line
« Land_area
3. Click the Obstacle check box for each of the following layers to enable them as obstacle layers:
«  MAP_TITLE
«  Post_Offices_point
«  Public_Schools_point
« Highways_line
+ Interstates_line
« Parks_area

Setup Layers
MName Label Obstacle OK
a San Francisco Downtown
I‘ HIGHWAY_INTERSTATE_labels [}
[T] LAND_labels
[T] MAP_TITLE

[T] PARK labels

[T] SCHOOL labels
[T| STREET labels

[ SUPPRESSED_labels

D000 SEEEOOOOOO

P Post_Offices_point =]
P Public_Schools_point
L Highways_line
T Interstates_line
L] Ramp_line (=]
L] Streets_line
[A] background B
[A] Land_area
[A] Parks_area ]

4. Make sure that the settings match the image above and click OK.

The MAP LabelPro dialog box gets updated according to the layers settings. Selected layers for labeling are
added to the Source list and selected layers for obstacles are added in the Obstacle layers list.

10 | MAPublisher 8.7 LabelPro Tutorial
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MAP LabelPro

Source Attribute Destination Priority Style Rules Suppression Layer Save &Label
4 [@ San Francisco Downtown
P| Public_Schoo... [§] FACILITYI [T HIGHWAY L. 1 [Default] [Default] 7| [lgnored]
Highways_line STREETNAME [T] HIGHWAY L. 1 [Default] [Default] 7| [lgnored]
Interstates_line STREETNAME [T] HIGHWAY L. 1 [Default] [Default] /1 [lgnored]
Streets_line [S] STREETNAME [T] HIGHWAY L. 1 [Default] [Default] /1 [lgnored]
Land area AREA NAME [T] HIGHWAY L. 1 [Default] [Default] 7 lignored]
Advanced...
Obstacle Layers: Source Art:
4 [@ san Francisce Downtown @ Label all art on source layers
P/ Post_Offices_point () Label only selected art on source layers
P Public_Schools_peint
Highways_line
Interstates_line
Parks_area

3.2 Labeling extents setup

The configuration described in this exercise will limit the creation of labels to the extent of the selected source
layers for labeling, with a margin of 0.2 inches on each side.

1. Click the Advanced button in the MAP LabelPro dialog box.
2. Under Label Placement Area, choose the option Extents of labeled source layers.
3. Click the Label Margins check box. Set the Top, Left, Right and Bottom drop-down lists to 0.20 in.

Note: If the option Paths without stroke are not considered obstacles is checked, areas that have no stroke will not be
used as an obstacle in the labeling process, allowing generated labels to overlap with them.

Advanced

Label Placement Area: oK

") Extents of the current artboard

) Cancel
@) Extents of labeled layers

Label Margins:

Top: 0.20 px =

left:  0.20px =

Right:  0.20px -

Bottom: 0,20 px =

Obstacles:

(=] Paths without stroke are not considered
obstacles

4. Make sure that the settings match the image above and click OK.

The label styles and rules of each source layer are now ready to be set.

MAPublisher 8.7 LabelPro Tutorial 1
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3.3 Point layer label settings
1. Inthe MAP LabelPro editor dialog box, click Public_Schools_point in the Source column to highlight the row.

By default, the attribute to use as a label is set to FACILITY_I, the first string attribute column of the
Public_Schools_point layer. It needs to be changed to SCHOOL_NAME.

2. Click FACILITY_I in the Attribute column. This enables a drop-down list with all the attributes of the
Public_Schools_point layer. Choose SCHOOL_NAME from the drop-down list.
3. Inthe Destination column, choose SCHOOL_labels from the drop-down list.

Source Attribute Destination Priarity Style Rules Suppression Layer
4 [@ san Francisco Downtown
P| Public Schoo... [SIEGEEY N EITEGEENTT 1 [Default] [Default] ¥4 [lgnored]
Highways_line [S] STREETNAME  [T] HIGHWAY INTERST... 1 [Default] [Default] " llgnored]
Interstates line [§] STREETMAME  [T] HIGHWAY INTERST... 1 [Default] [Default] 7 lgnored]
Streets_line STREETMAME  [T] HIGHWAY_INTERST... 1 [Default] [Default] /. llgnared]
Land_area AREANAME  [T] HIGHWAY_INTERST... 1 [Default] [Default] /" llgnored]

Note: Increase the width of an attribute column to see its full name.

Leave the Priority column set to 1. The Public_Schools_point layer will be labeled as a first priority while the
others will be set to a secondary priority.

4. In the Style column, click [Default] and choose School_Label_Style from the drop-down list. Click the Edit button
[.."|to open the Style dialog box and examine its settings. This style was predefined.

Source Attribute Destination Priority Style Rules
a 5an Francisco Downtown
JEECTETS M [ SCHOOL_NAME  yi SCHOOL labels 1 School_Label Style [ (]
Highways_line STREETNAME [T HIGHWAY_INTERST... 1 [Default] [Defautt]
Interstates_line STREETNAME [T HIGHWAY_INTERST... 1 [Default] ®  [Defauli]
Streets_line STREETNAME [T HIGHWAY INTERST... 1 [Default] [Default]
[A] Land_area AREA_NAME [T HIGHWAY INTERST... 1 [Default] [Default]
< m 3
Style
!
Family: [ T Verdana -I l oK J
Style: [Bold - [Ccaneel ]
Sz .00pt [
Sample Save As..

Note: The second labeling session will show how to create a new style from scratch.

v

After reviewing the Style settings, click OK to close it.

6. Inthe MAP LabelPro dialog box, under the Rules column, click [Default] and choose School_Label_Rule from the
drop-down list. Click the Edit button [ | to open the Point Rules dialog box and examine its settings. This style
was predefined.

12 | MAPublisher 8.7 LabelPro Tutorial
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Source Attribute Destination Priority Style Rules

4 [@ San Francisco Downtown

1 EICRICTEE | SCHOOL_NAME Wi SCHOOL labels 1 School_Label_Style @@E
Highways_line  [S] STREETNAME [T HIGHWAY_INTERST... 1 [Default] [Default]
Interstates_line  [§] STREETNAME [T] HIGHWAY_INTERST... 1 [Default] [Default]
Streets_line STREETNAME [T] HIGHWAY_INTERST... 1 [Default] [Default]
[A] Land_area AREA_NAME [T] HIGHWAY_INTERST... 1 [Default] [Default]

< i | v

Point Rules

Placement

[¥] Allow stacking |Up to 4lines =

Ci
= = o
@ o
3 2 [T] Allow labels to cross lines

New
i Yo
ocy
Select positions in order of priority.

Allow font reduction

Steps: 4 - A

Exch sep alows LabelPro w shvink the | A
selected font by 0.5 pt, # nacessary

Unselected positions will not be tried.
[] Centered on point

[T Allow use of leader lines
New Village [] Allow overlapping labels
Allowed Line Crosses: |3 yf
New -
Leader Width: 1.00pt bt @ Citya)
(W

1.0f

Arrow Style: Style #1

These point settings will force the labels to be placed below the symbols:

+ When possible, the text will be placed lower-middle to the symbol.

« If this is not possible due to space constrictions, text will be placed to the lower-right, and then to the lower-left.

« If none of the options can be applied, the text will be placed on the suppression layer (or ignored if no
suppression layer was specified).

« Text stacking and font reduction have also been enabled to add flexibility to the placement rules.

Note: More information on the available labeling options can be found in the MAPublisher User Guide, chapter 17.

7. After reviewing the Point Rules dialog box, click OK to close it.
8. In the Suppression Layer column, click the text [Ignored] and choose SUPPRESSED _labels from the drop-down list.

Labels that can not be placed will be copied to the SUPPRESSED_labels layer.

Note: Scroll to the right of the MAP LabelPro dialog box or expand it to see the Suppression Layer column.

This finalizes the configuration for the labeling of the Public_Schools_point layer. Do not close the MAP LabelPro
dialog box as the configuration of the roads and land layers still have to be set. If you want to save the current
configurations, click the Save button. You will have to reopen the MAP LabelPro dialog box to continue.

MAPublisher 8.7 LabelPro Tutorial | 13
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3.4 Line layers label settings

This section covers the labeling configuration for the source layers Highways_line, Interstates_line and Streets_line.
Highways and interstates will be labeled using highway and interstate symbol shields—notice that these layers
contain double-lines for each road (divided highways).

3.4.1 Label lines with symbols

A wWN =

14

In the MAP LabelPro dialog box, click the Highways_line layer name in the Source column to highlight the row.
In the Attribute column, choose HIGHWAY_NUMBER from the drop-down list.

In the Destination column, keep the destination text layer selected by default (HIGHWAY_INTERSTATE_labels).
Set the Priority column to 2.

In the Style column, choose Highway_Label_Style from the drop-down list. Click the Edit button to open the
Style dialog box and examine its settings. This style was predefined.

Style
Family: [ T Verdana v] [ oK J
Style: |Reguiar =] [ concal
Size:  10.00pt/=
= ==
Opacity: ) 100% B
Label with symbol
Symbol File: | generic_shields.lsf -
Symbol: @ United States Interstate ~ | Height:  0.25in %

In addition to the regular font settings, line labels can also be labeled with symbols. In this case, the Label with
symbol option is enabled. Symbol files (*.Isf) contain a series of symbols. In the example above, the United States
Interstate symbol is selected from the generic_shields.Isf symbol file. The symbol size is set to a height of 0.25
inches. The symbol font color is set to white so it can be legible against the blue symbol.

After reviewing the Style settings, click OK to close it.
In the MAP LabelPro dialog box, in the Rules column, choose Highway_Label_Rule from the drop-down list. Click
the Edit button [ .| to open the Line Rules dialog box and examine its settings. These rules were predefined.

MAPublisher 8.7 LabelPro Tutorial
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With these settings, the highway labels (and shields) will be placed in the middle of each line length and on the
centerline, with a font reduction (if necessary). The Divided Highways setting recognizes lines that are parallel
and share the same name (as specified by the selected attribute). In such cases, it places only one symbol
instead of two or more. The Allow labels to cross lines option needs to be enabled because double highway
lines are very close in proximity and the labels need to cross the lines. More information on line labeling rules
can be found in the MAPublisher 8.7 User Guide, chapter 17.

Note: Evaluation users will see a different result than a licensed user. Because of the text scrambling, the divided
highways cannot be recognized. Here is an example with the interstates:

Result with license: Result with evaluation:
[CT] - e

W] Ar

8. After reviewing the Line Rules settings, click OK to close it.
9. Inthe MAP LabelPro dialog box, in the Suppression Layer column for Highways_line, choose SUPPRESSED_labels
from the drop-down list.

The settings for the Highways_line layer are completed. Continue with the settings for the Interstates_line layer.

10. Click the Interstates_line layer name in the Source column to highlight the row.
11. In the Attribute column, choose INTERSTATE_NUMBER from the drop-down list.
12. In the Destination column, keep the destination text layer selected by default (HIGHWAY_INTERSTATE_labels).

MAPublisher 8.7 LabelPro Tutorial | 15
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13. Set the Priority column to 2.
14. In the Style column, choose Interstate_Label_Style from the drop-down list. Click the Edit button [.."| to open the
Style dialog box and examine its settings. This style was predefined.

Style
Family: [ T Verdana vl [ oK J
Style: |Regular - —
Size:  10.00pt/
colour: [l
Opacity: ) 100% B
Label with symbol
Symbol File: | generic_shields.lsf -
Symbol:  United States Route | Height: 0.25in |=

The United States Route symbol is selected from the generic_shields.Isf symbol file. The symbol size is set to a
height of 0.25 inches.

15. After reviewing the Style settings, click OK to close it.
16. In the MAP LabelPro dialog box, in the Rules column, choose Interstate_Label_Rule from the drop-down list. Click
the Edit button [_._| to open the Line Rules dialog box and examine its settings. These styles were predefined.

The labeling rules for the interstates are the same as for the highways. The previous note applies for evaluation
users.

17. After reviewing the Line Rules settings, click OK to close it.
18. In the Suppression Layer column, choose SUPPRESSED_labels from the drop-down list.

The label settings for the interstate roads are now complete. Continue with the street labels.

3.4.2 Label lines with text only

1. Inthe MAP LabelPro dialog box, click the Streets_line layer name in the Source column to highlight the row. Keep
STREETNAME as the selected attribute for labeling.

2. Inthe Destination column, choose STREET_labels from the drop-down list.

Set the Priority column to 2.

4. Inthe Style column, choose Street_Label_Style from the drop-down list. Click the Edit button to open the
Style dialog box and examine its settings. This style was predefined.

w
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Style

Famiy: | i Verdana v][ oK J
Style: [Bold -] (i)
Size:  6.00pt =

Colour: . e
Label case:

opadty: < D. 100% |+

[ Label with symbol
Symbol File: -

Symbol: ~ | Height: Auto

Notice that this time Label with symbol is not checked.

5. After reviewing the Style settings, click OK to close it.
6. Inthe MAP LabelPro dialog box, in the Rules column, choose Street_Label_Rule from the drop-down list. Click the
Edit button [.."| to open the Line Rules dialog box and examine its settings. These rules were predefined.

Line Rules
Starting Point o
¥ Mewowetbang:  WM0% [ o
start ¥ b
o] Cem
D s e e i
= [T
Save A
Placement
Mow etackng e
Défuet wrt
Honm s
-m e
@ Centerine Z o
4 Mo ot recucton
Sarps: 4 g AA
B Lobel oned festure e e S
ey .5 .  rwoeary
Label each feature
Alcw use of leader ines.
P Vil
R =
»
—E
Al averlapong Labels | §
Sgread words
)
- e tvng,

Like highway and interstate labels, street labels will be placed in the middle of each line length and on the
centerline, with an eventual font reduction if necessary. The ability to overhang is enabled here.

The street lines in this file are not joined. For example, each street is made of many line segments that all share
the same STREETNAME attribute. To avoid repeating the name of connecting lines, the Label joined feature rule
is enabled. MAP LabelPro recognizes that connecting lines sharing a same name need to be labeled only once.

Note: Evaluation users will see a different result than a licensed user due to the text scrambling. Names are not
recognized as being the same and labels will be created for each line segment rather than one per street.
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Result with license: Result with evaluation:
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7. After reviewing the Line Rules settings, click OK to close it.
8. Inthe MAP LabelPro dialog box, in the Suppression Layer column, choose SUPPRESSED_labels from the drop-down list.

This completes the label settings for all line layers. Do not close the MAP LabelPro dialog box as the configuration
of the Land_area layer still has to be done. If you want to save the current configurations, click the Save button. You
will have to reopen the MAP LabelPro dialog box to continue.

3.5 Area layer label settings

This section covers the labeling configuration for the source layers Land_area. The goal is to add large labels for the
land areas of the map (downtown area, Treasure and Alcatraz Islands).

1. In the MAP LabelPro dialog box, click the Land_area layer name in the Source column to highlight the row. Keep
AREA_NAME as the selected attribute for labeling.

2. Inthe Destination column, choose LAND_labels from the drop-down list.

Set the Priority column to 2.

4. In the Style column, choose Land_Label_Style from the drop-down list. Click the Edit button [ | to open the
Style dialog box and examine its settings. This style was predefined.

w

Style

Famiy: | o Aria - o ]
Style: [Regular - Cancel J

size:  70.00ptll [ ™
Save As..

Label case: |Leave asis -

Opadty: S 1) 100m[E]

Note: The sample text in the preview is cut off because the font size is set to 70 pt.

5. After reviewing the Style settings, click OK to close it.
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6.

Note:

In the MAP LabelPro dialog box, under the Rules column, choose Land_Label_Rule from the drop-down list. Click
the Edit button .| to open the Area Rules dialog box and examine its settings. These rules were predefined.

Area Rules

Placement

[ Allow horizental inside

[] Allow dominant angle

[l Allow extending beyond
boundary

[¥] Allow outside

Allow inside, along
] boundary

[Z] Allow use of leader lines
Allowed Line Crosses: |3
Leader Width: 1.00 pt

Arrow Style: Style #1

[¥] Allow stacking |Up to 3lines =

Alignment:

OK

Save As...

[T Allow labels to cross lines

Allow font reduction

Steps: 4 -

Each step allows LabelPro 1o shrink the
selected font by 0.5 pt, # necessary

[] Allow overlapping labels

7. After reviewing the Area Rules settings, click OK to close it.

8.

All layers have been now configured for the first labeling session.

The main requirement for labels created from the Land_area layer is that labels are placed in the water area.
Therefore, the Allow outside rule is the only placement option enabled. Stacking and font reduction option are
also enabled to give more flexibility to the rule. More information on the available area labeling rules can be
found in the MAPublisher 8.7 User Guide, chapter 17.

Labeling Session #2 will explain the creation of area rules for the Parks_area layer.

In the MAP LabelPro dialog box, in the Suppression Layer column, choose SUPPRESSED_labels from the drop-down list.
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3.6 Execute labeling with MAP LabelPro

1. Make sure that all the layers have been configured to match the image below and click the Save & Label button.

|

MAP LabelPro
Source Attribute Destination Priority Style Rules Suppression Layer _Save &ilabel
a San Francisco Downtown
P| Public_Schoo... SCHOOL_NAME [T] SCHOOL _labels 1 School_Label_Style School_Label_Rule [T] SUPPRESSED_labels ave
Highways_line [ HIGHWAY_NU... [T HIGHWAY_INTERST... 2 Highway_Label Style  Highway_Label Rule [T] SUPPRESSED labels
Interstates_line [M] INTERSTATE_N... [T] HIGHWAY_INTERST... 2 Interstate_Label_Style Interstate_Label Rule [T] SUPPRESSED labels
[L] Streets_line STREETNAME  [T] STREET labels 2 Street_Label_Style Street_Label Rule [Tl SUPPRESSED._labels
Land_area AREA_NAME  [T) LAND_labels 2 Land_Label_Style Land_Label_Rule [T SUPPRESSED._labels
Advanced...
Obstacle Layers: Source Art:
4 [@) San Francisco Downtown @ Label all art on source layers
P} Post_Offices_point ) Label orly selected art on source layers
P Public_Schools_point
Highwsays_line Export Settings...

Interstates_line
Parks_area

Note: For this session, the other labeling options will be kept as default:

+  Source Art: option to label all the source layers or label only the selected art on each source layer. In the
example above, all objects will be labeled exactly as found in the source attributes.

- Options: statistics type option displays a report on placed and non-placed objects. It will be used in the
Labeling Session #2. For this example, the option is set to None.

Note: For evaluation users only. Review the MAPublisher warning message and click OK to close it.

i The Evaluation version of Label Pro scrambles the text of placed labels but preserves the
\‘) case, spacing & punctuation so that the results give a sense of how actual labels would
be placed.

Please also note that Unicode & foreign glyphs are mapped on to standard Latin
characters when the labels are scrambled, but are fully supported in the licensed version

of LabelPro.

2. Wait for the process to end to visualize the results (see next page).

The map layers are labeled. Make the SUPPRESSED_labels layer visible to show labels that couldn't be placed
with the specified rules.

3. Save the file and leave it open to continue on with the second labeling session.
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Result with full license:

Note:

Evaluation users will observe scrambled labels on the map. The Label joined feature rule does not recognize
similar street names due to the text scrambling and places more labels than necessary. Similarly, highway
and interstate roads are labeled with two shields with different numbers. Licensed versions will not see any

text scrambling.
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In this second labeling session, continue with the San Francisco.ai file that you saved. This time, only the parks will

4 Labeling Session #2

be labeled in a single labeling execution of MAP LabelPro. The objectives are to:
Create a new area label style for park labels.
Create a new area label rule for park labels.

To start MAP LabelPro, click the MAP LabelPro button |E§'| on the MAPublisher Toolbar. The settings from the
previous labeling session are remembered. For the new session, the layer setup has to be changed to match the

Make sure that the park labels do not overlap with the other labels and with the post office and school
symbols, and do not cross highway and interstate lines.

new objective of this exercise. However, the label extents remain the same as before.

4.1 Layers and obstacles setup

w

5. Make sure that the settings match the image above and click OK.
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HIGHWAY _INTERSTATE_labels

SCHOOL_labels

STREET _labels

Post_Offices_point
Public_School_point

Highways_line
Interstates_line

In the MAP LabelPro Editor, click the Setup Layers button to setup the source and obstacle layers.

In the Setup Layers dialog box, click the very top Label check box (at the level of the San Francisco Downtown
MAP View). Click the check box again to uncheck all of the Label check boxes.
Click the Label check box of the Parks_area layer only.

Make sure that only the following layers are set as obstacles:

Setup Layers.

MName

EEEEEEEEEE R E R

4 [@) San Francisco Downtown

HIGHWAY_INTERSTATE labels
LAND_labels
MAP_TITLE
PARK_labels

SCHOOL labels
STREET labels
SUPPRESSED labels
Post_Offices_point
Public_Schools_paint
Highways_line
Interstates_line
Ramp_line
Streets_line
background
Land_area

Parks_area

Label

EOooooo@EEo

Obstacle

OO0000DEREEO0SEOOORE

Cancel

MAPublisher 8.7 LabelPro Tutorial

4 Labeling Session #2

The MAP LabelPro dialog box is updated with the new selected layer setup.




.
MAP LabelPro
Source Attribute Destination Priority Style Rules Suppression Layer Save &Label
4 [@ san Francisco Downtown
[A&] Perks_area LAND_ID I HIGHWAY_INTERST... 1 [Default] [Default] ! lignored] e
Advanced...
Obstadle Layers: Source Art:
4 |@ san Francisco Downtown @ Label all art on source layers
HIGHWAY_INTERSTATE labels ) Label only selected art on source layers
SCHOOL_labels
P| Post_Offices_point Export Settings
P/ Public Schools_point
Highways_line
Interstates_line

4.2 Additional area layer label settings

This section covers the labeling configuration for the source layer Parks_area. The goal is to add labels for the parks on
the map, allowing the use of leader lines and font reduction. In this exercise, style and rules are created from scratch.

© N A

In the MAP LabelPro dialog box, click the Parks_area layer name in the Source column to highlight the row.
In the Attribute column and choose PARK_NAME from the drop-down list.
In the Destination column, choose PARK_labels from the drop-down list.

Source Atribute Destination Priority Style Rules Suppression Layer Save &Label
4 [ San Francisco Downtown
Parks area I PARK_NAME IT) PARK labels i} [Default] [Default] ¥4 [ignored] e

Cancel

In the Style column, click [Default] and then click the Edit button [.._] to open the Style dialog box.
Make sure that Arial is selected in the Family drop-down list.

Make sure that Regular is selected in the Style drop-down list.

In the Size drop-down list, set the font size to 7.00 pt

Click the color chip and in the Color Picker dialog box, pick dark green color (e.g. R=0, G=85, B=0) and click OK.

Color Picker
Select Color:
A
|
[
B [Color Swatches
@H: 120 °
I Qs 100 %
©B 3 %

D.d @R 0 (=R
©6 85 M a0 %
©B 0 Y. 100 %

l . = 05500 K 40 ®
\ [l only web Calars i
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9. Make sure that the Style dialog box is setup as below and click Save As.

Style
Famiy: | m Aria - x|
Style: |Regular -][ﬁmm‘
Size:  7.00pt &

coour: [

10. In the Save As dialog box, type Park_Label_Style in the Name box and click Save.

Save As

Name: Park_Label_Style - o

11. In the Style dialog box, click OK to close it.

Source Attribute Destination Priority  Style Rules Suppression Layer Save &Label

el San Francisco Downtown

Parks_area i PARK_NAME i PARK labels 1 Park_Label Style |7 5 |[EEET] Yd [Ignored]

Cancel

In the MAP LabelPro dialog box, the Style column now displays the text Park_Label_Style. The style is saved in
the directory specified in the MAPublisher Preferences.

12. In the MAP LabelPro dialog box, under the Rules column, click [Default] and then click the Edit button [ .| to
open the Area Rules dialog box.

13. In the Area Rules dialog box, under Placement, click the check box for Allow extending beyond boundary.

14. Click the checkbox for Allow use of leader line. Keep the default parameters.

15. For the Allow stacking rule, choose Up to 4 lines from the drop-down list. Leave the alignment as Feature.

16. Click the check box for Allow labels to cross lines to disable the rule.

Area Rues
Placement r - [ ‘x” 0|
4| Mo stacing |Uptodioes - | B - J
£ Mow renzontal nsde bgrment: Featre
Alow demirant angle
7, Hom extendng beyord PP
N anisde
s- -
bondry
| Mlow font reducion
Steps: 4 0 A
| Ao use of leads s - Al
__52-:: Each g alown Labailes ek e | A
Aloverd Line Crenes: 3 2 sawied bt Iy 8.5 gL ¥ reuminacy
Leader Wdth: o
Mhow overlapping libels
Artow Styles
B
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17. Click the Save As button and in the Save As dialog box, type Park_Label_Rule in the Name box and click Save.

Save As

Name:  Park_Label Rule - e

18. In the Area Rules dialog box, click OK to close it.
19. In the Suppression Layer column, choose SUPPRESSED _labels from the drop-down list.

Source Attribute Destination Priority Style Rules Suppression Layer
4 [@] san Francisce Downtown
Parks_area ki PARK_MAME Ui PARK_labels 1 Park_Label_Style  Park_Label Rule [NV IITTR NN 0

In the MAP LabelPro dialog box, the Rules column now displays the text Park_Label_Rule. The rule is saved in the
directory specified in the MAPublisher Preferences.

4.3 Execute labeling with MAP LabelPro

1. Make sure that all the layers have been configured as below and click the Save & Label button.

MAP LabelPro

Source Attribute Destination Priority Style Rules Suppression Layer Save &Label
4 [@ San Francisco Downtown
Parks_area PARK_NAME [T PARK labels 1 Park_Label Style  Park_Label Rule [T] SUPPRESSED.labels save

Setup Layers..

Advanced...
Obstacle Layers: Source Art:

P
a @ San Francisco Downtown ! Label all art on source layers
HIGHWAY_INTERSTATE |abels abel only selected art on source layers
SCHOOL _lzbels -
P Post Offces point
P Public_Scheols_point
Highways_line
Interstates_line

The parks are labeled appropriately according to the style and rules defined in MAP LabelPro.
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2. Click the MAPublisher Log button on the MAPublisher Toolbar.

N
umtier g L e
Message When Layer
4 k3 LabelPro i i2 minutes age
&# Starting label generation
&9 Finiched label generation -Dﬁd Al
% Placing generated labels 2 minutes ago -
&9 Layer ‘Parks_area’: 44 label(s) were placed
&9 TOTAL: 44 label(s) were placed
Export
& & LabelPro labeling session 19 minutes ago -
snov: (@) [ @)
=\

Statistics about how many labels were placed (or not placed) on each layer are displayed in the log. Notice that
the first labeling session is also listed.

3. After reviewing the statistics, click Close to close the MAPublisher Log dialog box.

Result W|th full Ilcense' Result W|th evaluatlon Ilcense'

Congratulations, you have completed the MAPublisher 8.7 MAP LabelPro tutorial. For more in-depth information
on MAPublisher tools and features, please take a look at the MAPublisher 8.7 User Guide , MAPublisher 8.7 Tutorial
Guide and Quick Start Guide. These documents are installed with MAPublisher or can be downloaded from
http://www.avenza.com/documentation.
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